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Key Features

» Industrial-grade Xilinx Spartan-3A DSP FPGA module (1800 k gates or 3400 k gates)
= USB 2.0 (Hi-Speed USB) interface with a signalling bit rate of up to 480 Mbit/s
= 32-bit wide 1 Gbit DDR SDRAM
» FPGA configuration through:
= B2B connector
= JTAG port
» SP| Flash memory
= Large SPI Flash memory (for configuration and operation) accessible through:
» B2B connector (SPI direct)
"FPGA
= JTAG port (SPI indirect)
= USB bus (Firmware Upgrade Tool)
= On-board 100 MHz oscillator for high performance
» On-board 24 MHz oscillator available to user
= 3 on-board high-power, high-efficiency, switch-mode DC-DC converters capable of 3 A each
= Power supply range: 4.0-7.0V
» Power supply via USB or B2B (carrier board)
=4 LEDs, 2 push buttons, 8 DIP switches.
» Plug-on module with 2 female 1.27 mm pitch header connectors
» 109 FPGA I/O pins (+ 10 dual-purpose pins) available on B2B connectors
= Evenly spread supply pins for good signal integrity
= Assembly options for cost or performance optimization available on request
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5 Power Supply

5.1 Power Supply Range
The power supply range of TE0320is 4.0 Vto 7.0 V.

5.2 Power Supply Sources
TE0320 can be power supplied in two ways:

= through USB connector J1,
= through B2B connector JM5 (pins 1 to 4).
The power supply source is determined by assembly option. See Figure 5.

k2
USB 3.3V T :
J1 VCCAUX
VUSB R79  \sup
us _:'_l_ u7 FPGA
U7 Veeo BANK 0
B2B

JM5

- BQ...LI— us
R11_T_ u9

Figure 5: Power supply options diagram

If resistors R9 and R11 are populated and R12 is not populated, then TE0320 is
power supplied through JM5 (B2B connector).

Figure 6: assembly combination for power supply through JM5.

If resistors R9 and R11 are not populated and R12 is populated, then TE0320 is
power supplied through J1 (USB bus).
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Figure 7: assembly combination for power supply through J1.

Any other assembly combination of R9, R11 and R12 is not allowed.

5.3 On-Board Power Rails

According to the Xilinx Spartan-3A DSP literature, there are the following power
supply pin types:

» Vceaux: dedicated auxiliary power supply pins

= Vcenr: dedicated internal core logic power supply pins

»Vceo: supplies power to the output buffers within the 1/0O bank and sets the
input threshold voltage for some I/O standards.

TE0320 has the following power rails on-board:

=\/sup
It is the main internal power rail irrespective of the external power supply. It is
supplied by either Vb2b or Vusb. It manages power distribution, conversion
and supervision. It is routed also to connector JM5 as a user power supply
output.

*Vb2b
It is the main power rail when the module is supplied from B2B connector JM5.

=\Vush
It is the main power rail when the module is supplied from USB mini-B
connector J1. The maximum current than can be provided to J1 is determined
by the USB power source.

=3.3V
It is converted from Vsup by a step-down DC/DC converter and can provide up
to 3.0 A to the module and connectors JM4 and JM5.

=2.5V
It is converted from Vsup by a step-down DC/DC converter and can provide up
to 3.0 A to the DDR SDRAM and connectors JM5.

=1.2V
It is converted from Vsup by a step-down DC/DC converter and can provide up
to 3.0 A to the Vcenr power supply pins and connectors JM5.

= VCCAUX
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Figure 10: assembly option for VCCAUX = off (bottom view).

Pins 30 and 44 of JM4 are power supply inputs in this case.

(b) if resistor R131 is not populated and R132 is populated, VCCCIOO power
rail is set to power rail 2.5V (nominal voltage = 2.5 V).

Figure 11: assembly option for VCCAUX = 2.5 V (bottom view).

Pins 30 and 44 of JM4 are power supply outputs in this case.

(c) if resistor R131 is populated and R132 is not populated, VCCCIOO0 power
rail is set to power rail 3.3V (nominal voltage = 3.3 V). This is the default.

oy

Figure 12: assembly option for VCCCIOO0 = 3.3 V (bottom view).

Pins 30 and 44 of JM4 are power supply outputs in this case.

Assembly option where both R131 and R132 are populated is not allowed.

1.2V, 2.5V and 3.3 V voltage rails are provided by corresponding step-down
regulator DC/DC converters, each one capable of providing up to 3 A of output
current. These three regulators are synchronized to switch with 120° phase lag,
to improve EMC, and to reduce input ripple. The synchronization circuit can be
omitted in cost sensitive applications (please contact Trenz Electronic).
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Table 23: mode pin MO0 settings.

si8
M2@FPGA 2 7
@ ~ | GND
M2 @ IM5
sic
M1@FPGA 3 6 16w
M1@IM5
MO@EPGA
MO @ IM5

Figure 44: configuration modes schematic

10.2 Configuration via USB bus

To configure a TE0320 module via USB bus, there are different procedures to
follow according to module status and purpose of use. For instance, a full
guality control test already performed at Trenz Electronic laboratory premises
requires all the following steps to be performed:

(a) generic USB device driver installation

(b) USB microcontroller large EEPROM programming
(c) specific USB device driver installation

(d) FWU file generation

(e) Firmware Upgrade Tool utilization.

first following EEPROM quality
step development development control
recovery
cycle cycles ((ELR R
(a) . °

(b)

(c)

(d)

(e)

Table 24: configuration steps via USB bus according to module status and purpose
of use.
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Hardwareinstallation

] E Die Software, die fir diese Hardware installiert wird:
L

Assistent fiir das Suchen neuer Hardware

Fertigstellen des Assistenten

Cypress Generic USE Device . L . )
Die Software fir die folgende Hardware wurde installiert:

=

hat den ‘Windows-Logo-Test nicht bestanden, der die K.ompatibilitat mit

windowes <P Uberpriift. fafarum ist dieser Test wichtig?] Cypress Gieneris USB Devios

Das Fortsetzen der Installation dieser Sof kann die komekte
Funktion des Systems direkt oder in Zukunft beeintrachtigen.
Microsoft empfiehlt strengstens, die Installation jetzt abzubrechen
und sich mit dem Hardwarehersteller fiir Software, die den
Windows-Logo-Test bestanden hat. in Yerbindung zu setzen.

[ Installation fortsetzen | [ Installation abbrechen

Klicken Sie auf "Fertig stellen”, um den Yorgang abzuschiiefien.

 Fertig stellen |

After successful installation of the generic device driver, TE0320 should be
identified as “Cypress Generic USB Device” and the Device Manager panel
should look like Figure 46.

L Gerdte-Manager

Datei  Aktion  Ansicht 7
& 2 =R

+] r;y" Anschlisse (COM und LPT) S
+- @), aodio-, Yideo- und Gamecontraller

+-38 Bildbearbeitungsgerate

+- iy Computer

+ ik DVDYCD-ROM-Laufwerke

+- {85 Eingabeger &te (Human Interface Devices)
- »j Grafikkarte

+-{=4) IDE ATASATAPI-Contraoller

+|- g Laufwerke

+ "y Mause und andere Zeigegerate

+ .5 Monitare

+- B8 Metzwerkadapter

+ - Prozessoren

+-age Speichervolumes

+ _g Syskemgerate

+-«igs Tastaturen

=] %ﬁ USE-Controller

CA-200
Cwpress Generic LISE Device w

Figure 46: Device manager after successful installation of the generic device driver.

Now the EZ-USB microcontroller can be controlled from a computer by the
Cypress USB Console.

10.2.2 USB microcontroller large EEPROM programming
TEO0320 users are not normally required to perform this step.

Disconnect the TE0320 from the USB bus or leave it unconnected if it already
is.

Ensure that DIP switch S1 is set as follows:

»S1A = OFF

this disconnect the serial data line between the USB microcontroller and the
large EEPROM; in so doing, the USB microcontroller enumerates as a
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Cypress generic USB device
= S1B and S1C = do not care
configuration mode is irrelevant for this step

=S1D = OFF
master reset disabled

switch S1 label signal name status
S1A 1 EEPROM serial data| OFF
S1B 2 M2 X
S1C 3 M1 X
S1iD 4 /MR (master reset) | OFF

Table 26: S1 settings for forcing the EZ-USB FX2LP USB microcontroller
to enumerate as a generic USB device driver.

Figure 47: S1 settings for forcing the EZ-USB FX2LP USB microcontroller
to enumerate as a generic USB device driver.

Connect the TE0320 to a USB port on your computer using a USB cable.

The USB microcontroller should now enumerate as a Cypress generic USB
device.

Toggle S1A to ON; this will

= Connect the serial data line between the USB microcontroller and the large
EEPROM,;

= Allow the EZ-USB FX2LP USB microcontroller to program the large EEPROM,;

= Prevent the EZ-USB FX2LP USB microcontroller to enumerate again for any
content of the large EEPROM.

switch S1 label signal name status
S1A 1 EEPROM serial data| ON
S1B 2 M2 X
S1C 3 M1 X
S1iD 4 /MR (master reset) | OFF

Table 27: S1 settings for programming EZ-USB FX2LP USB microcontroller large
EEPROM.

()
N

—=Lru—

Figure 48: S1 settings for programming EZ-USB FX2LP USB microcontroller large
EEPROM.
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£ PROM File Formatter

®

Configure MultiBoot FPGA
[=}- BPI Flash

Configure Single FPGA

Location

Step 1. Select Storage Target Step 2, Add Storage Device(s) Step 3. Enter Data
Storage Device Type © Terget FPGA [m—— General File Detal walue
Checksum Fil F
(= Non-Wplatile FPGA Storage Device (hiks): 517K value
(- SPI Flash Add Storage Device | | Remaove Storage Device g R |
Configure Single FPGA

Output Filz

Ciiilin

Configure MultiBoot FRGA

Configure from Paralleled PROMs
Generic Parallel PROM

Auto Select PROM

Description:

Flash/PRCM Fils Praperty
ol E—
Use Power-of-2 for Start Addr |No

Mumber of Bitstream 2

Bitstream 0 Start Address a

Bikstream 1 Start Address

Add Mon-Configuration Data Files |Ves

Tumber of Data Fils

Value
HEYx

B7S540

programmed PROM device can then be used ko configure the karget FPGA.

Additional capabilities of the PROM File Formatter include:

« Grneratinn PROM files rontaininn snerific FPGA canfinuration instroctions renuirer b sunnork daisy-rhainsd FPEA hirstream BIT file

The PROM File Formatter wil quide you through the steps ko Format bitstream EIT files inte a PROM file that is compatible with lin<® and third-party PROM programmers. The

w

Select step 2. add storage device(s) / auto select PROMof the

middle panel and press the right green arrow.

? ROM File Formatter E‘
Step 1. Select Storage Target Step 2, Add Storage Device(s) Step 3. Enter Data
Storage Device Typs © FHETRl e General File Detall yalue
Hilinx Flash/PROM “hecksum Fill F
(= Mon-Wolatile FPGA Device (bits) wcfOls [1mM] Yalue
Spartan3ai FN—— o
(= SPI Flash Add Storage Device Remaove Storage Device utpuE File Nams. | Untide
Configure Single FPGA Qutput File =
Configure MultiBoot FPGA Location CHilin =
(= BPI Flash
Configure Singls FPGA »
Configure MultiBoot FRGA FlashfPROM File Property Value:
= (=) | .
Generic Parallel PROM
Enable Revisioning Yas
Mumber O Revisions
Enable Compression Mo
Description:
In this step, you will enter information to assist in setting up and generating a PROM file for the targeted storage device and mode, ~
* Checksum Fill ¥alue: When data is insufficient ta fill the entire memory of a PROM, the value specified here is used ta calculate the checksum of the unused portions.
* Dutput File Name: This allows you ko specify the base name of the file to which your PROM data will be written
* Dutput File Location: This allows you to specify the directary inwhich the file named abowve will be created
« File Enpmat: BROM Filas can ha nanarated in any numbar of industey standard foemas. Deanandinn an e PROM Fls farmat woe PROM nranrammear isss. swou kot 2 TEK st
[ o [ g J[ ek

In step 3. enter data of the right panel

stype fpga in the output file name input field;
= choose a suitable path for the output file location input field;
»select BIN (swap bits ON) from the drop-down menu file format in

the flash/PROM file property sub-panel;

= press the OK button in the bottom left corner of the current window.
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£ PROM File Formatter,

Configure Single FPGA

Configure MultiBoot FPGA

Configure from Paralleled PROMs
Generic Parallel PROM

3

Step 1. Select Storage Target Step 2, Add Storage Device(s) Step 3. Enter Data
Storage Device Type © E— i General File Detail value
ilinx Flash{PROM Checksum Fil F
& Non-Wlatile FPGA Device (bits) alue

Spartan3an — ;

(- SPI Flash Add Storage Device | | Remave Storage Device Hput i Hame | Fpga
Configure Single FPGA Output File
Configure MultiBoat FPGA Lacation CifDaten

[=}- BPI Flash

E FlashfPRCM File Praperty Yalue
File Format BIN (Swap Bits O [&

Enable Revisioning Mcs
EXO

Mumber OF Revisions TEE
HE (Swap Bits Oh)

Enable Ci

nable Compression e

.ap Bits OFF)
] ap Bits ON)
BIN (Swap Bits OFF)
UFP {'C' Farmat)

15C

Auko Select PROM

Description:

In this step, you will enter information ko assist in setting up and generating a PROM file for the targeted storage device and mode, ~

* Checksum Fill Yalue: ‘When data is insufficient to il the entirs memory of a PROM, the value specified hers is used to calculate the checksum of the unused portions,
« Dutput File Name: This allaws you ta spacify the hass name of the fils to which your PROM data will be written

* Dutput File Location: This allows you to specify the divectary in which the file named above will be created

« File Enrmat: PROM files can he nenerated in anv number of industry standard formats. Denendinn on the PROM Fils farmat wor PROM nronrammer Dse

aunuLE A TFK.

oK

[ concel ][ veb

Any other name than fpga for the output file name input field is not

allowed.

£. Add Device

3

]

Stark adding device file to
Revision: O

Add Device

Suchen in: | 1 implementation

~| & Bk

I_\§ (ycache

@chipscnpa_icnn_ﬂ_wrapper

Zuletzt (CT)chipscope_ila_D_wrapper
vervendete D.. (Cclock_generakor_0_wrapper
() ddr_sdram_wrapper
(debug_module_wrapper
(Chdimb_cntle_wrapper
(L ydimb_wrapper
(Cilmb_cntl_wrapper
(ilmb_wrapper
(led_wrapper
(lmb_bram_wrapper
(b _plb_wrapper
(Cimicroblaze_0_wrapper
@proc_sys_reset_ﬂ_wrapper

T

Desktop

Eigene D ateien

=8

Abeitzplatz

ErsZSZ_wrapper

) spi_Flash_wrapper

(L) switches_wrapper
IC)xps_Fx2_0_wrapper
Expstcfslavejfwrapper
Exps_intc_ﬂ_wrapper
Bxps_ﬂpi_\:lma_ﬂ_wrapper
@xps_t\mer_ﬂ_wrapper

system, bit

<

Metzwerkumgeb
ung

Dateiname: |down|oad bit

Offnen |

Dateityp:

|FF‘GA Bit Files [* bit]

=
j Abbrechen

Add Dewvice

Revision: O

\‘:j w'auld yau like ko add another device File ko
-

[ Nes

Mo

||

Just acknowledge the pup-up message.

Browse to the . /implementation/ folder of
your "." project folder and select the bit-stream
file download.bit.

Press the open button in the bottom left corner

of the current window.

Your design likely consist of just one device file.
So deny the request by pressing the NO button.
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10 Configuration UM-TEO0320 (v2.08) 22 February 2012

€. Add Device

L) You have completed the device file entry,
x.__E) Click 'O’ to continue Just acknowledge the pup-up message.

Select operations / generate file... or double click generate
file... fromthe iMPACT processes panel.

. ISE iMPACT - [PROM File Formatter: Xilinx Flash/PROM] = 1B (X]
‘@ File  Edit  View BeEEEEN Output  Debug  Window  Help - |8 x

A=A IR Access eFUSE Registers ¥ [T & K2

iMPACT Flows Generate File. .. L)
‘B3l Boundary Scan
‘5ol Slaveserial
‘Bl Direct SPI

[£] SystemacE
E Creake PROM File (PROM File Formatter)

xc3ed] 8008
covwnload kit

MPACT Processes +0F x

Available Operations are:
=) Generate Fils..,

HEw1d [ Wadd

<

=73 PROM File Formatter: ¥ilinx Flash/PROM

Console 08 X
dp INFO:iMPACT: 501 - '1': Added Device xcisdl800a successtfully. ~

Add one device.fa3sl
< | ¥

Console Erraors ‘Warnings

Generate System ACE or PFF file PROM File Generation | | Target Xilinx PROM | | 8, 197,280 Bits used | | File: fpga in Location: Ci\Daten)

||
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You should see the following message in the main panel: generate
succeeded.

£. ISE iMPACT - [PROM File Formatter: Xilinx Flash/PROM] N=E3
@ File Edit ‘Yiew Operations OQutput Debug ‘Window Help - 0 X
LA E|iw ||BOi,lNR
iMPACT Flows +0F X a”
‘53l Boundary Scan 0:x0000_0000
‘o3l Slaveserial -
=9 Direct SPI -
[£] SystemacE i [
Creake PROM File (PROM File Formatter) - - ; EIXILING
| i PROM
El xcf08p
xc3ed] 8008
covwnload kit
2| o download. bit
|
iMPACT Processes +0&F x = |2
=
Available Operations are: = s
=) Generate Fils... T
0:000F_FFFF
-
@ PROM File Formatter: Xilin: FlashfPROM
Console +08 X
Writing file "C:%Daten'fpga.sig". -~
Writing file "C:%Daten'yfpga.cfi”.
// *%% BATCH CMD : setCurrentDesign -wversion O
-
< >
Console Errars ‘Warnings
PROM File Generation | | Target Xilinx PROM | |8, 197,280 Bits used | | File: fpga in Location: C:\Daten)
£ iIMPACT-Save Project
::/ Save current project before exiting? You might now want to save your Xilinx iMPACT
- . .
project settings for future use.

T T

In the folder corresponding to the path you chose as the output file
location, you should find the fpga.bin PROM file.

10.2.4.3 FWU file from the PROM file

Once you have got your fpga.bin PROM file, you can proceed and generate
your FWU (= FirmWare Upgrade) file. The FWU file is a ZIP archive containing
3 files:

"Bootload.ini — TE0320 booting settings (see paragraph 10.2.4.3.1
Bootload.ini file)

» fpga.bin — FPGA configuration PROM file
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= master reset disabled (S1D set to OFF)

S1 Silabel signal status
S1A 1 EEPROM serial data | ON
S1B 2 M2 ON
Sic 3 M1 ON
S1D 4 IMR (master reset) OFF

Table 29: S1 settings for configuration via USB bus.

Figure 51: S1 settings for configuration via USB bus.

10.2.5.3 Slide Switch S2

Ensure that slide switch S2 is set to FX2 PON.

switch signal status
S2 PON/FX2 PON | FX2PON

Table 30: S2 settings for SPI Flash programming via USB bus.

sl

Figure 22: S2 settings for SPI Flash programming via USB bus (FX2 PON).

This will

= allow the EZ-USB FX2LP USB microcontroller to power off the FPGA,

= release the SPI lines driven by the FPGA and made them available to the EZ-
USB FX2LP USB microcontroller

= allow the EZ-USB FX2LP USB microcontroller to program the SPI Flash
memory.

10.2.5.4 FUT upgrade procedure

Open USB Firmware Upgrade Tool (double click
step5 user\USBFirmwareUpgradeTool.exe).

=} USB Firmmware Upgrade Tool

Device: |

File name: |

|¥ USE EEPROM

J Wersion: 4.1
] ueaaly | | Press the “. . ." button corresponding to the
W FPGA FLASH File name:
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11.2 Unused IOB Pins

All signals entering and exiting a Xilinx Spartan-3 generation FPGA must pass
through the I/O resources, known as 1/0O blocks or IOBs. Users can specify the
configuration for any unused IOB pins. This is the serial data outputs for all
JTAG instruction and data registers.

This options are set graphically in Xilinx ISE Software Project Navigator by
selecting the following:

= Generate Programming File > Process Properties > Configuration Options >
Unused I0B Pins

Select an option from the drop-down list.

(a) Pull Down
Default. All unused I/0O pins and input-only pins have a pull-down resistor
to GND.

(b) Pull Up
All' unused 1I/0 pins and input-only pins have a pull-up resistor to the
VCCO_# supply for its associated 1/0 bank.

(c) Float (also: Pullnone)
All unused 1I/0O pins and input-only pins are left floating (Hi-Z, high-
impedance, three-state). Use external pull-up or pulldown resistors or logic
to apply a valid signal level.

11.3 CCLK Frequency

In SPI Flash mode, the FPGA’s internal oscillator generates the configuration
clock frequency. The FPGA provides this clock on its CCLK output pin, driving
the PROM'’s Slave Clock input pin. The FPGA begins configuring using its
lowest frequency setting. If so specified in the configuration bitstream, the FPGA
increases the CCLK frequency to the specified setting for the remainder of the
configuration process. The maximum frequency is specified using the
ConfigRate bitstream generator option. The maximum frequency supported by
the FPGA configuration logic depends on the timing for the SPI Flash device.
For TE0320 SPI Flash PROM, use ConfigRate = 12 or lower.

This options are set graphically in Xilinx ISE Software Project Navigator by
selecting the following:

= Generate Programming File > Process Properties > Configuration Options >
Configuration Rate > 12 (or lower)
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Initializing temperature to 85.000 Celsius.
Initializing voltage to 1.140 Volts.

Device speed data version:

Design Summary Report:

Number of External IOBs

"PRODUCTION 1.33 2010-02-13".

(default - Range:
(default - Range:

0.000 to 85.000 Celsius)

119 out of 519

Number of External Input IOBs 30
Number of External Input IBUFs 30
Number of LOCed External Input IBUFs 30
Number of External Output IOBs 43
Number of External Output DIFFMs 2
Number of LOCed External Output DIFFMs 2
Number of External Output DIFFSs 2
Number of LOCed External Output DIFFSs 2
Number of External Output IOBs 39
Number of LOCed External Output IOBs 39
Number of External Bidir IOBs 46
Number of External Bidir IOBs 46
Number of LOCed External Bidir IOBs 46
Number of BSCANs 1 out
Number of BUFGMUXs 5 out
Number of DCMs 1 out
Number of DSP48As 3 out
Number of RAMBI16BWERS 30 out
Number of Slices 7304 out
Number of SLICEMs 1156 out
Number of LOCed Slices 125 out
Number of LOCed SLICEMs 83 out

Overall effort level (-ol):
Router effort level (-rl):

High
High

out

out

out

out

out

of 1
of 24
of 8
of 84
of 84

of 16640

of 83

of 73
of 11

of

of

of

of

of

20

04
56

30

39

46

1

00%
20%
12%

o
]

35%
43%
13%

~
o

o°

22

100%

100%

100%

100%

100%

1.140 to 1.260 Volts)
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12 Reference Design Summaries (ISE 11.5)

UM-TE0320 (v2.08) 22 February 2012

12.2 Reference Design Summary for Xilinx Spartan-3A DSP 3400

platgen -p xc3sd3400afg676-4 -lang vhdl -lp x:/xxx/projects EDK/

Release 11.5 - platgen Xilinx EDK 11.5 Build EDK LS5.70
Copyright

(c) 1995-2009 Xilinx, Inc. All rights reserved.

(nt)

system.mhs

Command Line:

Running post-placement packing...

Design Summary:

Number of errors: 0
Number of warnings: 1272
Logic Utilization:

Number of Slice Flip Flops:
Number of 4 input LUTs:

Logic Distribution:

Number of occupied Slices:
Number of Slices containing only related logic:
Number of Slices containing unrelated logic:

6,442 out of
8,290 out of

7,889 out of

platgen -p xc3sd3400afg676-4 -lang vhdl -lp

47,744
47,744

23,872

7,889 out of
0 out of

13%
17%

33%

7,889 100%
7,889 0%

*See NOTES below for an explanation of the effects of unrelated logic.
47,744

Total Number of 4 input LUTs:

Number
Number
Number

(Two
Number

used as logic: 6,212
used as a route-thru: 372
used for Dual Port RAMs: 1,892
LUTs used per Dual Port RAM)

used as Shift registers: 186

8,662 out of

18%

The Slice Logic Distribution report is not meaningful if the design is
over-mapped for a non-slice resource or if Placement fails.

Number of bonded IOBs:
IOB Flip Flops:
IOB Master Pads:
IOB Slave Pads:
Number of ODDR2s used:

Number of DDR ALIGNMENT
Number of DDR ALIGNMENT

NONE
co

Number of DDR ALIGNMENT = C1

Number
Number
Number
Number
Number
Number

Number

of
of
of
of
of
of

of

BUFGMUXs :

DCMs:

BSCANs:

DSP48As:
RAMB16BWERS :
BSCANisPARTAN3AS:

RPM macros: 1

Average Fanout of Non-Clock Nets:

119
39
2

2
44
44
0

PO WwWRrkrFu o

out

out
out
out
out
out
out

of

of
of
of
of
of
of

469

24

126
126

25%

20%
12%
100%

o
]

23%
100%

60/82

www.trenz-electronic.de

TEO0320 Series User Manual


http://www.trenz-electronic.de/

12 Reference Design Summaries (ISE 11.5)

UM-TE0320 (v2.08) 22 February 2012

Initializing temperature to 85.000 Celsius.
Initializing voltage to 1.140 Volts.

Device speed data version:

Design Summary Report:

Number of External IOBs

(default - Range:
(default - Range:

0.000 to 85.000 Celsius)

1.140 to 1.260 Volts)

"PRODUCTION 1.33 2010-02-13".

119 out of 469

Number of External Input IOBs 30
Number of External Input IBUFs 30
Number of LOCed External Input IBUFs 30
Number of External Output IOBs 43
Number of External Output DIFFMs 2
Number of LOCed External Output DIFFMs 2
Number of External Output DIFFSs 2
Number of LOCed External Output DIFFSs 2
Number of External Output IOBs 39
Number of LOCed External Output IOBs 39
Number of External Bidir IOBs 46
Number of External Bidir IOBs 46
Number of LOCed External Bidir IOBs 46
Number of BSCANs 1 out
Number of BUFGMUXs 5 out
Number of DCMs 1 out
Number of DSP48As 3 out
Number of RAMBI16BWERS 30 out
Number of Slices 7889 out
Number of SLICEMs 1156 out
Number of LOCed Slices 125 out
Number of LOCed SLICEMs 83 out

Overall effort level (-ol):
Router effort level (-rl):

High
High

out of

out of

out of

out of

out of

of
of
of
of
of
of
of

of
of

24

126
126
23872
11936

7889
1156

30

39

46

100%
20%
12%

o
]

23%
33%

o

~
o°

25

100%

100%

100%

100%

100%
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14 High Resolution Pictures UM-TE0320 (v2.08) 22 February 2012

14 High Resolution Pictures
(a) Figure 53: TE0320 high resolution top view.
(b) Figure 54: TE0320 high resolution bottom view.
(c) Figure 55: TE0320 angle view.
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18 B2B Connectors Pin Descriptions UM-TE0320 (v2.08) 22 February 2012

18.4.1 JM4 Signals Trace Length

FPGA FPGA JM4 . JM4 FPGA FPGA len.
JM4 pin . .
singal ball pin mm

pin ball singal

1
26 | 10 L20P 0 | F15 | JW4-I001 | 3
29 |10 L2INO | Cc16 | Jw-1002 | 5 | 6
7
9

8 | JM4-I034 | K12 | 10 L39N 0 | 29
26 | 10 L21P. 0 | D17 | JW4-I003 10 | JM4-1035 | J12 | 10 L39P 0 | 26
24 | 10 L22N 0| C15 | JW4-1004 | 11 | 12 | JIM4-I036 | D8 | IO_L4ON O | 26
26 | 10 L22P 0 | D16 | JW4-I005 | 13 | 14 | JM4-I037 | C8 | IO L40P 0 | 24
21 |10 123N 0 | A15 | Jw4-I006 | 15 | 16
20 | 10 L23P 0 | B15 | JW-I007 | 17 | 18 | JM4-1038 | C6 | IO_L4IN O | 24
22 |10 L24N 0| F14 | JM4-1008 | 19 | 20 | JIM4-1039 | B6 | IO L41P O | 24
18 | 10 L24P 0 | E14 | JWA-I009 | 21 | 22 | JM4-1040 | C7 | IO L42N O | 23
23 | 24 | JM4-I041 | B7 |10 L42P 0 | 19

20 | 02001 n4 | w010 | 25 | 26 | 4042 | K11 | 10L43NO | 24
21 | 0520 kia | w011 | 27 | 28 | awa-043 | 911 | l0L43PO | 23
11| 020 ata | amaior2 | 29 | 30
11 | 9200 | B14 | ami013 | 31 |32 | w1044 | D6 | 0_L4NO | 15
17| 000 | 613 | o014 | 33 |34 | IM4-I045 | C5 | 10L44P0 | 14
16 | 0270 F13 | o015 | 35 | 36 | JMAI046 | B4 | IO_L4SNO | 15
37 | 38 | JM-1047 | A4 |10 L45P 0 | 14
13 | Goiei | C13 | JMA-I016 | 39 | 40 | JMA-I048 | HIO | I0_L4GNO | 14
12 'Oééfﬁ':ao B13 | JMA-1017 | 41 | 42 | JM4-1049 | G10 | IO_L46P.O | 14

14 | 10 L29N 0 | B12 | JM4-I018 | 43 | 44
14 | 10 L29P 0 | A12 | JM4-1019 | 45 | 46 | JM4-1050 | H9 | 10 L47TN.O | 15
27 |10 L30N 0 | C12 | JM4-1020 | 47 | 48 [ Um4-1051 | G9 | 10 L47P 0 | 14
30 | IO L30P 0 | D13 | JM4-I021 | 49 | 50 | JM4-I052 | E7 | 10 L48N O | 13
51 | 52 | JMA-I053 | F7 | I0_L48P 0 | 15
20 | I0_L33N 0 | B10 | JVM4-I022 | 53 | 54 | JM4-I054 | B3 | IO LBGIN.O | 9
17 | 10 L33P 0 | A10 | JM4-1023 | 55 | 56 | JM4-I055 | A3 | I0 L51P 0 | 9
20 | 10 L34N 0 | D10 | JM4-1024 | 57 | 58
21 | 10 L34P 0 | C10 | JW-I025 | 59 | 60 | JM4-1056 | C23 | IO_LO6N 0 | 36
29 | 10 L35N 0 | H12 | JM4-1026 | 61 | 62 | JIM4-I057 | D23 | I0_LOBP 0 | 42
30 | 10 L35P 0 | G12 | JM4-I027 | 63 | 64 | JM4-IO58 | A22 | 10 LO7N 0 | 36
65 | 66 | JMA-I059 | B23 | I0_LO7TP O | 41
27 | 10 L36N 0 | B9 | JW4-I028 | 67 | 68 | JM4-I060 | G17 | IO_LOSN O | 36
27 |10 L36P 0 | A9 | JM4-1029 | 69 | 70 | uM4-1061 | H17 | 10 LO8BP 0 | 39
28 |10 L37N 0| D9 | Jw-1030 | 71 | 72
34 | I0_L37P. 0 | E10 | JM4-I031 | 73 | 74
29 |10 138N 0| B8 | JWM-I032 | 75 | 76
28 | 10 L38P 0 | A8 | JM4-I033 | 77 | 78
79 | 80

Table 42: trace length of signal pins of B2B connector JM4.

78/82 www.trenz-electronic.de TE0320 Series User Manual


http://www.trenz-electronic.de/

